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TWAUG NEWSLETTER

TWAUG NEWSLETTER is published
bi-monthly when possible, whithout

the support of contributers it’s difficult
to fulfill this promise.

It is printed and published by TWAUG
no other publishing company is
involved.

Opinion expressed by authors, in this
newsletter, is their own opinion and
do not represent the views of
TWAUG

The Atari Fuji symbol and Atari name
are the trademarks of Atari Corpora-
tion. The Fuji symbol on the front
cover, is for informational purposes
only.

TWAUG is entirely independent and
is in no way connected with Atari
Corporation or any associate
company.

Do you need to Contact anyone at
TWAUG, for a chat, then phone

Alan Turnbull on: 01670 - 822492
or Max on: 0191 - 586 6795

Our Postal address:
TWAUG
c/o J.Matthewson
80 George Road
Wallsend, Tyne & Wear,
NE28 6BU

Max’s Comments
We are still looking for a person who
can REVIEW Games for us to include
into the newsletter. The reward is,
unfortunately not cash, but the person
can choose from the PD library. | am
pleased to say that we had at last
some articles donated from two
subscribers, some pieces are
included in this issue and another two
articles will be in the next issue.

Besides this help we are still looking
for writers, at the moment it all boils
down to me and it is hard work and a
little help would certainly ease my
workioad. So please think about it
and give poor old Max a hand.

AMS 98

Please do not forget the Stafford
SHOW at Bingley Hall on November
the 14th.

| have been told that this convention
will be well represented by busines-
ses selling Atari products.

The Portfolio Club UK have also
confirmed they will have a stand and
of course TWAUG will take their
usual place and John has informed
me that we will have a CDROM disk
on SALE, check the back page for
more details.
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PUBLISHING!

This newsletter is set up with the
Desktop Publishing program
"TIMEWORKS 2%, with a
Mega | ST and 4 meg of
memory. Files received are first
converted into ASCII format and
then transferred to the ST
usually with TARI-TALK. The
files are then imported into the
DTP and printed with the
CANON BJ-30 Bubble Jet
Printer at 360 dpi.
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nissue 29, [ wrote a little article

about Timeworks 2 the Desktop

Publishing program I use to

produce the issues of the
TWAUG newsletters. In issue 30 |
wrote about Calamus Desktop
Publishing and now at long last have
sufficiently mastered PageStream 2.2
and I’m now able to write a small
article to compare this DTP program
with the previous two.

I don’t know why I collect so many
DTP programs wouldn’t you think

that one or maybe two would

be enough to set up a
newsletter? 1 collect
programs to find the

best one for use. |

N
cP

purchased this

PageStream %‘ 2.2
quite a while Q now
but only just found the
time to see what it can do and

also compare it with all the others I've
got. Besides a very good manual there
is also a very well written QuickStart
Guide that comes with it.

I wanted to write an article on
PageStream, but | do not like to write
about objects I'm not familiar with,
that’s the reason I really got stuck in
and learned how to use PageStream. It
took me nearly a week to get to know
all the commands and be able to use
this DTP to its full capacity. It’s not
really a very difficult program to

e

work with, it has some nice features
which Timeworks hasn’t got and yet |
still prefer to use Timeworks.
Timeworks is without doubt the
easiest DTP program to use, | learned
its workings much quicker than any
other DTP program including
PageStream. As I said above it took
me nearly a week to get to know
all the commands and yet |
still cannot do
%‘ without the
manual.
This article has been
set up and printed with
PageStream, it has taken me a
bit longer with this program but
at least you can see it does the job.

I will include some screen shots of
some of the screens into the article to
give you a visual idea what the
screens look. I included some screen
dumps into the Timeworks and
Calamus articles so [ may as well do it
in this article too.

Timeworks, Calamus, Easy Text Pro
and Easy Text Vector are all Frame
based program, that means you must
first draw frames for text or images
before you can enter anything.
PageStream is different no frame
needs to be drawn.

When the program has loaded and the
toolbox appears you can open the
document window. The screen looks

Tyne & Wear Atari User Group 4




TWAUG NEWSLETTER

similar to the screen shot below. To
start a new document move the mouse
pointer to the File menu on the menu
bar and click the New Document
command. This will open a dialog box
where you can select the page size, i.e.
A4, A5 size, single or double sided
pages. this is of course an important
guide for you as well as for the
program. The default is a single sided
8.5 x |1 inch page size, if you click on
OK with the left mouse button the

Desk File

Edit Layout View Style

document window will open.

All other DTP program, after you’ve
opened a new document the screen
will display a 6 column window,
PageStream shows a blank window, as
above. The easiest way to lay out
columns is with the Create Columns
command in the Layout menu from
the menu bar. A dialog box will open
to select the size, number and

placement of the columns. This option
is also available in the other DTP
programs mentioned above. The
outlines of the columns are now
visible by dotted lines, if there are no
columns, choose the Show Columns
Outlines option from the View menu
to make them visible.

There are many other options you can
select to make it easier working on the
page. The rulers can be made visible

Format Text Object Glabal

[o]lel (] Vg g

at the top and left of the document
window, toggled from the View menu,
it makes it easier to place any lines or
boxes more accurately.

If you want to enter some text into the
columns visible on the screen, with
PageStream you can type it in or
import an ASCII file from any word
processor. Just select the Text tool

5 Tyne & Wear Atari User Group




TWAUG NEWSLETTER

from the toolbox, click on the capital
A at the top of the oblong box on the
right of the screen. The cursor will

change to an [-beam

cursor move it into the
column, click the left

mouse button and the
text cursor will appear
where you click the
mouse button. You
can now start typing or
importing text from
the text cursor.

B

,‘l

There is no need to
draw a frame in
PageStream, to enter
text in the other DTP
programs mentioned
above a frame has to
be drawn first before
you can enter any text
or graphics. This is
one of the differences
in this program.
Another nice option |
. » like in PageStream is
the way a header can
be entered into the document. If the
cursor still resembles the I-beam, you
can click outside the column and type
the header, then select the Pointer tool
from the toolbox, that is the pointer to
the right of the capital A, the cursor
will change back to an arrow. The text
object you’ve just created, the header,
will now be surrounded by a dotted
line with size handles at its corners

e
~loloL

|2
on =]
'Ela

and mid-points. If you now point the
arrow at one of the handles click and
hold the left button you can drag the
mouse and the outline text object will
follow the pointer and resize the
element.

There is one option though in
PageStream I miss and that is placing
a footer at the bottom of the page. As
you will notice, of course you will
have how silly of me, I always place
the month and year in the centre at the
bottom of each page with the page
number. With PageStream you must
place the cursor where ever you want
it, even for page numbering and type it
out. Once the page number has been
place it will number each following
page automatically, but not the month
and year_In Timeworks you select
the Header/Footer option, type it into
the dialog box, left, right and centre
options provided and the program
places the header/footer at your
selected margin.

PageStream has a Rotate command
which is missing in Timeworks, |
would have like to see the rotation
option in that program. You can
rotate, slant and twist text or graphics
objects in PageStream,

One good option though when running
PageStream is you do not need the
Graphics Device Operating System
(GDOS), Timeworks, wili not run
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without GDOS.

In the first column on the previous
page | included the screen shot of the
Toolbox, which is on the right side of
the screen. The box contains a
selection of icons, or tools, which you
use to draw or edit your document.
Like any other DTP you select a tool
with the left mouse button.

Lets start with the Text Tool, the
capital A, this tool is used to enter and
edit text. When you click the left
mouse button on this icon the cursor
will change to an I[-beam cursor which
is used to highlight text, creating text
objects and placing the text cursor in
text columns and text objects. Text
may be imported or entered from the
keyboard into columns and text
objects with the Text Tool selected.

The Pointer Tool, to the right of the
Text Tool, is used to select page
elements. When selected size handles
will appear around the selected
elements, small square boxes, these
may be moved, resized, filled,
reshaped. rotated with the Pointer
Tool..

The icon below the A the Magnifying
Tool is used to zoom in on the
elements. When the tool is highlighted
the cursor changes to the shape of the
icon, place it anywhere and click the
left mouse button and the element will

Zoom in.

To the right of the magnifying glass is
the Reshape Tool. This tool is used to
change the shape of polygons,
polylines and bezier curves, elements
other than those mentioned above can
also be manipulated as if the Pointer
Tool were selected.

The third icon down is the Column
Tool, it is used to draw text columns
for holding text. The cursor will
change to a crosshair for accurate
drawing.

The next seven tools are the Drawinf
Tools. The diagonal line is the Line
Tool, it is used to draw lines such as
the centre and bottom lines on this
page. The rest of the Drawing Tools
are used to draw squares, round
cornered rectangles, circles, ellipses,
circular arcs, elliptical arcs, polygons,
polylines, Bezier curves and freehand
objects.

The Page Change Tools, below the
Zoom Tool, are used to change and
view master pages. The arrow icons
are used to move forward and
backward one page at a time. If either
arrow icon is selected while Shift is
pressed, PageStream will move to the
first or last page containing an
element.

The page number indicator displays
the current page number.
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The screen shot above displays a
document window with a double
column selected page and the Rulers
visible. When I selected the New
Document from the File menu I chose
the AS page size and Double Sided
Document. I then moved the cursor to
the Layout option, on the menu bar
and selected Create Columns and
chose two columns as in the
newsletter.

If the ruler and columns are not visible
after you’ve selected them you can
make them visible by selecting the
Show Rulers and Show Column
Outline from the View menu.

The screen shown in the screen dump
is the actual size. This is the size I
always use to enter text or graphics.

41 4

The page in actual size is shown at
100%, the text is displayed in true
WYSIWYG, (What You See Is What
You Getd

The only problem, when the page is
shown in actual size, it doesn’t display
the full page, to see the full page select
the Show Full Page from the View
menu. While the text on the page will
not be readable it will demonstrate the
overall layout.

THE END
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The Atari 8-bit Hardware Upgrade,

Modification and Add-On FAQ

® Version 0.1
Dated February 18, 1995

Maintained by: David A. Paterson
Mailto:d.paterson2 @ genie.geis.com

INTRODUCTION

his is a very basic version. |

intend to add as people give

feedback to what they want to

see, and how they want to
see it. Any info you have is more than
welcome!

PURPOSE

This FAQ exists to describe the
various hardware modifications
available to the Atari 8-bit user. it
does not teach you how to do them. It
definitely doesn’t take any responsibi-
lity for the results if you do try them.
But it will try to give you some
information about where to find more
information, which upgrades (or
“hacks”) are best, and who to consult
if things go wrong. For addresses and
phone numbers of any of the
companies listed, consult the
Vendors and Developers List, posted
at or about the 15th of each month.

It also exists to describe the many

wild and wonderful products that have
been produced for the Atari 8-bit.
Many are unique, some may be
apocryphal. Mainstream items like
printers, modems, disk drives and
cassette decks are all excluded.
Temperature gauges, combination
printer buffer/ramdisks that run
through the joystick port, and other
such are fair game.

POSTING FREQUENCY

This FAQ is posted whenever |
remember to post it. It is posted to
comp.sys.atari.8bit.

INDEX

¥ Part | RAM Upgrades listed by
computer

Part 2 Video Upgrades 80 Col-
umn devices Genlocks

Part 3 Operating Systems

Part 4 Other Neat Stuff stereo
sound, add-ons

S

o

P

Kev t bi iati
O ANL - Analog Magazine

O  AC - Atari Classics Magazine
O  ANT - Antic Magazine

O  AIM - Atari Interface Magazine
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% PART | - RAM Upgrades
General

The 6502 microprocessor at the heart
of every Atari 8-bit has a sixteen bit
wide address bus. What this means is
that it can access up to 216 memory
locations. That's 65536 bytes. Some
people, wanting more memory, came
up with a variety of techniques to use
more memory. Most were built
around the idea of bank switching.
Bank switching means that you swap
chunks of memory around so that the
CPU can see them when necessary.
Most schemes use 16k banks, though
4k and 32k have also been tried.

Atari 400

The original Atari 400 had either 8k or
16k. Atari produced a board with 48k.
Mosaic produced a 32k board, as well
as a 64k board with 48k RAM plus 4
4k RAM banks. (ANL 13, IFC)

Atari 800

The Atari 800 came with three
memory slots. Each slot could contain
Atari 8k or 16k RAM boards. Mosaic
produced 32k and 64k boards. Three
64k boards could be combined for
192k.

Axlon produced the 128k RAMdisk
board. It banks 16k, using $CFFF as
a control register. Banked memory
appears from $4000 to $7FFF.

David Byrd created the “800 PLUS
288K UPGRADE” which rewired
existing 16k RAM boards, but
required additional work to become
fully Axion compatible. A nasty sort of
flame war erupted between David
Byrd and Jay Torres of the Windho-
ver Project over who invented the
upgrade.

Magna systems produced 256k, 512k
and 1M boards which followed the
Axlon standard. (ANL 65, 68)

Atari 1200xI
See 800x1.

Atari 600xIi

As shipped, the Atari 600xlI came with
16k RAM. Atari released the 1064
memory module which expanded the
600xI to 64k. MPP, now Supra,
produced the Microram 64k Memory
Board (ANL 19, 28)

RC Systems produced three
expansion modules for the 600xI,
raising memory to 32k, 48k or 64k
(ANL 26, 12)

Richard Gore produced the Yorky, a
256k board which plugs in to the PBI.
It provides full compatibility with
130xe type banking. It is for use on
600xIs upgraded internally to 64k, or
on 800xis. (AC 3/2, 10)
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Atari 800xI|

The Atari 800x! came with 64k RAM
internal. To access RAM hidden
under the OS ROMSs, the PIA chip
was used (PORTB, used for

STICK(2) and (3) on the original 800).

Claus Bucholtz published plans for a
256k upgrade which banked 32k at a
time using PORTB for control in Byte
magazine. (Byte Sept 85)

ICD released the RAMBO upgrade,
providing 256k in 16k banks, using
PORTB. Newell came out with the
256k XL, which would work on a
1200xI or 800xi, providing 256k total
memory, . The two upgrades used
different sequences to access their
banks. (ANL 44, 115)

Charles Bucholtz updated his
upgrade to use 16k banks after the
release of the 130xe. Most of the
800xi upgrades can be made
compatible with Antic banking. The
only possible problem would be when
Antic and the CPU are supposed to
be using different memory banks.

The Yorky will also provide 256 on an
800xI (see the entry under 600xi).

Newell released 1Meg and 4Meg
upgrades for the 800xI. These
banked 16k as well, and required
disabling internal BASIC to properly
access the memory.

Fine Tooned Engineering, having
bought the rights to ICD and Newell’s

products, is bringing out a third
method in the Mars 8. Though not yet
released, it will use SIMMs for 256k,
1Meg or 4Meg RAM.

Atari 130xe

The 130xe was the first “official”
method of banking memory. It too
used PORTB, but with an added
twist: ANTIC and the CPU could
access different banks. This provided
headaches for some owners of
“older” upgrades, but few programs
took advantage of this feature
(SpartaDos Wedge and VideoBlitz
demo only).

Upgrades for the 130xe include
replacing one set of 64k chips with
256k chips, raising the RAM to 320k.
Adding another 256k for 576k total
has also been done. These were
designed by Scott Peterson, as was a
1088k upgrade.

# PART II - Video
Upgrades

The most common video upgrades
are the SuperVideo series, described
in AC 2/6. Plans were provided for
the 600x|, 800xl, 1200x! and 130xe.
The SuperVideo upgrade provides
the forgotten chroma signal on the
monitor port. it corrects a number of
errors in the parts in the Atari video
circuit, resulting in a clearer image,
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particularly on monitors.

Providing TTL output was also
covered in AC 2/6. Bob Woolley
provided plans for the circuit, as well
as instructions for getting TTL output
from an XEP80. Be warned that the
output is not in the standard Atari
colours; on a CGA type screen, the
sixteen possible shades are
translated into eight colours.

80 column devices

Since the 400/800 were released in
1979, people have been clamouring
for better text displays than the
default 40x24. Two products were
released for the 800: The Austin-
Franklin 80 column board and the Bit
3 80 column board were both for use
in the Atari 800. They replaced the
third memory module. The Austin-
Franklin board came with a “Right

Cartridge” which provided the drivers.

Removing the cartridge disabled the
board. Some software would not run
with an 80-column board installed.

Ace 80/80xI was a cartridge released
which provided 80 columns by using
bitmapped graphics on an 80 column
screen. A similar technique was used
in the Newell Omniview, an add-on
for their Omnimon.

Atari’s entry into the 80 column field
was the much maligned XEP80. For
maximum compatibility, the XEP80
attaches to the computer via a

joystick port. It includes three
character sets, 8k internally, and a
parallel printer port. The software
provided by Atari supports a 320x200
graphics mode. This mode only
supports direct bit images. Hacks
have been released which hook the
XEP80 on via the parallel bus.

Genlock

In October and November of 1991,
Michael St Pierre published articles in
the SLCC Journal describing pians
for a monochrome Genlock. A
genlock is a system to synchronize
live video with a computer image.
Graphics can be overlaid, faded in or
out, or used for titling.

in 1994, Michael announced Prism
Studio, & full colour genlock. It is sold
by Mytek.

¥ PART HI - Operating Systems
Computer OS -----—--- --
400/800 Rev A. No self test; Memo

Pad mode. Rev B. Fixes several bugs
in Rev A.

1200x1 XL OS. Some incompatibilities
with 400/800 OS

600x1/800x] Revised XL OS. includes
parallel bus handlers. Internal BASIC.

65xe/130xe Revised XL OS. (as
above)
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xegs Modified XL OS. Self-test mode
changed. internal Missile Command
and BASIC.

Operating System upgrades
UltraSpeed + OS . from CSS.
Supports high speed disk communi-
cation. Drives 1 through 9. Any RAM
upgrade. Includes three modes:
standard xl/xe OS; 400/800 OS;

UltraSpeed+ OS. For XL/XE systems.

Omnimon: from Newell. M/l monitor
for 400/800. Instalis into $C000 page
of memory, otherwise unused.

RAMROD OS: from Newell.
Replacement for 400/800. Includes
accelerated floating point math
package.

RAMROD XL: from Newell. OS
speed-up routines, fast math, and
Omnimon. Includes option for second
Os.

XL Boss: from Allen Macroware. OS

replacement for XL modei computers.

Includes m/l monitor. 400/800 OS
compatible.

TurBoss: available from KP and Best.

Fast math and fast screen routines.
For XL/XE computers.

v« PART IV - Other Neat Stuff
Zucchini

In ANL 59,60 and 62, Dr. Lee S.

Brilliant provided plans and software
to turn a surplus Atari into a printer
buffer for another Atari. He called it
“The Atari Zucchini”.

The Printer Buffer Routine (PBR) and
Disk Emulator Routine (DER) came
from B.L. Enterprises. They were
cartridges and cables which worked
in a similar fashion to the Zucchini.
The PBR provided a buffer, while the
DER emulated a disk drive on the
remote computer. Stock XLs gave
403 free sectors; a 130xe would give
914. (ANL 65, 67)

Voice Master

Covox sold the Voice Master and
Voice Master junior. These would
capture and record speech. Bundied
softwarerattempted recognition of
commands, with limited success.
(ANL 47, 44)

Parrot

The Parrot was a sound digitizer sold
by Alpha Systems. Resembling a
paddle, the device had phono jack for
input. Antic provided plans for a
similar project, called the Antic
Sampling Processor. (ANT 8/8, 11)

SoundMouse

Among the more esoteric products
ever released was the SoundMouse,
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which interpreted sound to provide a
reading on a paddie register. It did
not act as a digitizer, like the Voice
Master and Parrot did.Bundled
software made the lava lamp look
mainstream in its appeal. No
commercial applications taking
advantage of this unique device were
released.

Gumby

Chuck Steinman of DataQue created
this set of plans for building stereo
sound by installing a second Pokey
chip (Pokey and Gumby, get it?).
Once installed, the second channel
has all its addresses 16 bytes higher
in memory ($D210 - $D21F). A small
number of demos have been
released in stereo. ftp://
atari.archive.umich.edu/Atarif
8bit/Sound/gumby.arc

PIA2

With the use of PORTB for RAM
banking, hackers were looking for
more parallel outputs. This plan, for
adding one more PIA chip, includes
notes for adding two more. It was
intended as a means to control farge
RAM upgrades. (AIM 3/2, 16)

Critical Connection

A long time ago, in a galaxy far, far
away, was a mystic operating system

known as CPM. A company named
USS Enterprises produced the Critical
Connection, a device to permit a
CPM computer to emulate disk drives
for the Atari. It was a cable, pius
software for the CPM end of the
system. The CPM system could also
act as a printer buffer, and the CPM
keyboard could be used in the place
of the Atari keyboard. (ANL 39,103)

SIO2PC

With the demise of CPM and the rise
of the IMI cartel (IBM-Microsoft-intel)
a new system similar to the Critical
Connection arose. Nick Kennedy
developed the SIO2PC hardware and
software, which permits any PC with
a serial port to act as up to four disk
drives fQr an Atari. It can also act as a
printer buffer.

Computer Eyes

Computer Eyes was a video capture
system which plugged into two
joystick ports. It could render images
in a variety of modes. It required a
composite video source. (ANL 35, 53)

Easy Scan

Take a cartridge, add a fibre-optic
cable, and hook it onto a printer, and
you've got Easy-Scan, an image
scanner for the Atari 8-bit. Innovative
Concepts produced this item. (ANT
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716, 43)

WIMA Radio, Lima, Ohio

This radio station, when automating 6
broadcast hours daily, created a
hardware and software package built
around a 130xe for control. Control
was via joystick ports and tone
decoders. (ANT 8/7, 30)

Comp-U-Temp

This provided 8 or 16 channels and 2
or 4 sensors. It would monitor the
temperature, with options to log
results to disk or printer, or to sound
an alarm if the temperature strayed
out of set boundaries. The software
was described as “cumbersome”.
(ANL 48, 35)

Turbo 816

Released by DataQue, this provided
a replacement OS as well as a
replacement for the 6502 CPU. A
65816 was substituted, providing new
opcodes and a 24 bit address space
(16Megs vs 64k with the 6502).

Sweet 16

Released by Fine Tooned Engineer-
ing, this provides a 65816 CPU to
replace the 6502.

MIDIMATE

MIDI stands for Musical Instrument
Digital Interface. It is a system for
computers to record, replay and
control musical instruments.
MIDIMATE, when combined with
MidiTrack software, permits an Atari
8-bit to take control. (ANL 33, 26)

MicroNet

Supra provided the Atari community
with its first networking product.
MicroNet provides nine SIO
connectors. Eight are for computers.
The ninth goes to whatever
peripherals are to be connected. The
system served to isolate the
computers electrically. 1t did no
software checking, meaning that two
or more users attempting to print or
save at the same time could trash
each others output. (ANL 51, 76)

MultiPlexer

CSS provided a better way to
network. The Multiplexer system
requires one host system which has
all the disk drives and printers for the
network. The slaves are connected
via the cartridge port to the host, and
all their disk and printer ifo is rerouted
to the host. All the systems involved
require their OS replaced with a
special multiplexer OS.
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MIO

ICD manufactured this wonderboard
in 1987. Connected to the PBI or ECI,
it provided either 256k or 1Meg of
RAM, two RS232 ports, a parallel
printer port and a SCSI hard drive
port.

MIO 1l

Currently under development by Fine
Tooned Engineering, this PBI/ECI
board will provide an interface and
power supply for an IDE hard disk. It
may also include extended memory
support for CPU upgraded com-
puters, as well as a paraliel port.

Black Box

CSS manufactures the Black Box, a
PBI/ECI device that offers an optional
64k printer buffer. Its main attractions
are its m/l monitor, 19200 baud
RS232 port, parallel port, and hard
disk interface. The paraliel and serial
ports do not use standard DB9 or
DB25 connectors; custom cables are
required.

Floppy Board

This is an add-on to the Black Box,
also from CSS. It permits standard
floppy drives, 360k, 720k, 1.2M and
1.44M, to be attached to the Black
Box. Since they are connected to the

PBI, these drives operate extremely
quickly.

Supra/KP Hard Disk
Interface

Supra released one of the first hard
drives for the 800xI. It hooked up via
the PBI. KP bought the rights to the
interface from Supra.

R-Time 8

This is a clock cartridge for any Atari
from Fine Tooned Engineering. It
includes a pass-through connector so
that any other cartridge can be
plugged in as well. Though primarily
intended for SpartaDos, software for
other DOSes is included.

Mars-8

This is still under development from
Fine Tooned Engineering. For 800xis
only. Memory expansion of 256k, 1M
or 4M. Install internally Action, Basic
XL/XE, MAC/65, SpartaDos X,
R-Time 8.

Atari 850

This device hooks into the SIO line,
and provides 4 9-pin RS232 ports
and a 15-pin parallel port. The RS232
ports are NOT IBM PC standard. The
MIO and PR Connection use the
same pinout.
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P:R: Connection

This device plugs into the SIO line,
and provides 2 9-pin RS232 ports
and a 15-pin parallel port. It is
powered by the SIO line. The Atari
1200x! requires an internal modifica-
tion to work with this device, or with
the Atari XM301 300 baud modem.

Voice Box I

Manufactured by the ALIEN Group,
this speech synthesizer even made it
into TIME Magazine in their “Machine
of the Year” issue in 1982. Plugging
into the SIO line, this device would
produce speech of the traditional
computer variety.

R/128 RAMdisk Printer
Buffer Spooler

Protronics of California announced
this 128k RAMdisk/printer buffer
which interfaced via the joystick ports,
offering it as a replacement for the
850. A 512k upgrade was promised.
(ANT 2/8, 106)

N1858-32

Newell industries announced this 850
replacement in 1983. It offered two
serial and one parallel port, along
with an expandable 8k printer buffer.
(ANT 2/8, 106)

Oscar Model 1

This bar-code scanner was from the
Databar Corp. The intent was to
permit the speedy entry of computer
programs which would be encoded in
magazines. (ANT 2/8, 107)

1200XL PBI

Hackers love the 1200xI for two
reasons: because of all the space
available within the case, and
because of the great keyboard. Bob
Woolley came up with this set of
plans for adding a parallel bus
interface to the 1200xl.

ftp://atari.archive.umich.edu/
Atari/8bit/Modifications/pbi1200.arc

Wanting to get in touch with
any TWAUG member via
e-mail?

Here are the addresses:

John Matthewson:
J.Matt@ Cabieinet.co.uk
Alan Turnbull;
a.b.t@zetnet.co.uk

Max Gerum:
amg@zetnet.co.uk
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BUSINESS OR PLEASURE

here is quite a large number

of TWAUG members now

who use a second computer

with their 8-bit, i.e. an Atari
ST and wondering what this computer
can do.

Your ST is the perfect companion for
any business activities, be it personal
or professional. Have you ever
dreamed to be your own boss?
Working from home could be the
answer.

You don’t need to be a high-powered

done on my humble ST.

| never made any financial gains for
the work | was doing, it was all done
for friends who were doubtful about
the ability of the ST, and | do it all for
pleasure. So you see it can be done
and there’s no need at all to spend
thousands of pounds when a few
hundred will do.

I've got a room set aside which is set
up as a small office and | know loads
of people who have a similar set up
and get results to rival those from

executive to

work from home. Your ST is the perfect
companion for any”
business activities,
produce projects be it personal or
professional.

If you are a
student who
needs to

or essays and
are expected to

more expensive
computers. For
those seeking
financial gains
will surely find
some good
ideas to make a
few bob running

hand in neat homework. For most
people this could mean spending
over a thousand of pounds for a PC.
A friend a mine just done that, he
spend nearly 2 thousand pounds on a
PC for his son to do his home work
on. | have spend about a quarter of
that maybe less for my ST set up and
| do the Desktop Publishing, home
finances and Databases on it. | have
also done some CV'’s, posters and
fliers, invoices and tax returns, all

a small business from home with the
ST.

Despite its age, the ST is one of the
most versatile computers going. With
its expansion capabilities, you can
connect all kinds of modern
equipment to it, including scanners,
CD-ROM drives, hard drives,
modems and MIDI equipment.

Here are a few ideas to run as a
small business. Running any mail
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order enterprise, such as a PD
library, for example could employ
many of your ST’s abilities. You could
duplicate disks using FAST-
COPY.PRO, this program is an ideal

Protext is another, you will also need
a desktop publishing program and
some art software. For the desktop
publishing program you don’t need to
look far for an idea, PageStream is

disk copying - - available
toolif yourun The best business i1s the cheaply
aPDservice. one you think of yourself nowadays,
You can there is also

specify the number of floppies you
want to duplicate and it's much faster
than using the Desktop’s copying
facilities. | use this program for all my
copying.

Print labels using any of the PD
labelling utilities available and keep a
customers database on your ST.
There are a number of database
programs available. One exampile is
AtariWorks, this integrated package
provides a word processor, a
database and a spreadsheet. You
can exchange data files between its
various components and is ideal for
business use. But it does need at
least 2mb of RAM.

How about running an art and design
service? This service is ideal for any
small organisation, such as a local
club, parish church, or even a one
man business who could require
posters, cards or newsletters. Many
such small bodies lack any computing
equipment of their own, that's where
you come in providing for all their
graphical needs. All you will need is a
word processor, I've mentioned one
of the many available above, or

Timeworks, Calamus or Easy Text
Professional.

Or what about running a Musical
Service. If you have a MIDI keyboard
and plenty of musical skill you can
use your ST to produce jingles and
incidental music for local performers.
You might be able to persuade a
local drama group or a DJ to
commission an original piece of your
music to use in their act. The best
businesgis the one you think of
yourself, so look for a gap in the
market, there are no rules and no
limits, although it’s always good to
make a profit.

Or what about a scanning service for
other computer users, A4 size
scanners have come down in price in
the last couple of years. Or how
about offering a genealogy service
using Family Roots 2.

Accounts, if you look after the
pennies the pounds will take care of
themselves. You will need financial
data to check the health of your
business. To keep abreast with your
profit and loss accounts you need an
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accounts package, | use Personal
Finance Manager, still available and
cheap. This program was one of
Atari’s productivity packs, it's very
good value. This program can help in
good financial management. In
business you need to know who owes
you what, manage your cash flow and
prepare your tax returns. By

PUBLISHING
BUSINESS

ou’ve read so far and
you know how to use
desktop publishing

Youdon’t need to run a
business to use any of
the programs available
for the ST, you could

keep a check on your

personal finances, or

write the odd letter

with your word processor

programs, you have a
flair for document layout and
now your are searching for
success - financial or
otherwise in your own
publishing business. You are
armed with the best tools
available to you. Apart from
the right hardware and
software combination, you aiso
need your own stationery.

presenting your data visually enables
you to make dicisions more easily,
the Personal Finance Manager does
just that. You don’t need to run a
business to use any of the programs
available far the ST, you could keep a
check on your personal finances, or
write the odd letter with your word
processor, or try out your skill, by
using a Desktop Publishing program
and set up a flier or your own invoice.

By shopping or looking around all the
software mentioned above can be
picked up cheaply now, so there is no
need to dig too deaply into your
pocket and | must say that these
programs do a professional job.

Lets look at the hardware, in
my opinion your ST should have 4
Meg of RAM, besides the internal
floppy a hard drive is a must. The
reason | say the hard drive is a must
is because you don’t have to change
disks and you can have a greater
selection of fonts, and is much faster
to access the programs.

For the software 1 would recommend
the best Desktop Publishing program,
Calamus, there is a big selection of
Calamus fonts available. it also has
its own art program.

You are now set up for your
business, you must remember that if
you intent to offer your services on a
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professional basis, you will need your
own stationery which should also look
professional. The first thing is a name
for your business - try and think of
something memorable but not too
long. Now you need to decide what
information should be displayed on
your business card.

Do not over do it, the problem with
listing all your services on the card
can look very messy. The most
attractive cards are the simple ones
where there is just the company
name, card holder’s name, address,
telephone and fax numbers.
Remember that the quality of your
work will be judged solely on the
artistic presentation of your business
cards, so it is well worth giving some
extra thought to the final appearance.
To give you an idea what looks good,
collect as many different cards as
possible. Unless you have been
trained in graphics design, keep
things simple and you won't go far
wrong.

address, telephone and fax numbers
to give a more pleasing effect.
Experiment, but try and stay faithful to
the overall company image. This
applies equally to your own stationery
or to a prospective client’s.

Since you may not have actually
done any outside work at this stage
and depending on the type of work
you want to do, at some stage you
are likely to be asked for examples of
your work. Prepare a portfolio with
some samples of your work you are
prepared to do and put them into an
A4 ring-binder which can be bought
at any stationers with plastic wallets.

Try printing some samples on
coloured paper to give a visual lift to
the overalil appearance of your
portfolio_ There are a multitude of
paper tints, weights and grades on
the market which can significantly
enhance your work. Your portfolio
could include A4 posters, or party
invitations, sales leaflets, CV’s,

invoices,
Your . newsletter
letterheads T.he qua ]._1ty of your work front pages,
and will be judged solely on club
compli- the artistic presentation  Membership
ment slips . cards,
shoudbe Of your business cards labels,
designed anything at
ona all you feel

similar format to your business cards.
Depending on the style of your
company name, you may find that
you need to change the layout of the

is likely to be applicable to the people
you want to attract to your business.

if you use Calamus for your DTP
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program, you will find that there are
thousands of fonts available. You
could start by printing out all your
fonts in your library, typing in ” The
quick brown fox jumped over the
sleeping lazy dog,” gives you every
letter of the alphabet. Arrange the
fonts in sections beginning with the
serif-types, followed by the non-serif
types. Serif type fonts such as Time
Roman, Garamond and so on.
Non-serif fonts such as Helvetica,
Futura ect. And ending with the fancy
fonts like Script or Old English. But do
not forget to print the font name
alongside each example. Next, gather
together all your best clip-art and
print out a good selection, if you
would like more clip-art than you've
got at the moment, there are loads of
outlets that sell them.

There are loads of brochures and
leaflets pushed through your letter
box - hang on to them, as they can
become a useful source of inspi-
ration, who knows, it might not be
long before your work becomes a
source of inspiration to others. Study
advertising in newspapers and
magazines for the techniques
professional ad people use for getting
messages across. It’s surprising how
many clients not only ask you to
provide the layout when you're
putting a leaflet together, but also
expect advice on the sales message.
You may not feel too confident
tackling that sort of thing at first, but

with a bit of practise, you will probably
find you actually enjoy it. And you get
paid for it!

There you have the perfect and
professional way to start your desktop
publishing business - now all you
need to think of is that inspirational
name...

| have been there, I've done it. As
mentioned above | have advised on
sales messages, printed invoices,
restaurant menus and posters. But |
haven’t got the T-shirt!!!
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AtariWorks Wordprocessor
Database & Spreadsheet

n the article - BUSINESS OR

PLEASURE - | mentioned that |

use Atariworks, so I've decided to

introduce you to this integrated
package of word processor, database
and spreadsheet. This package is a
real GEM of a program especially
when you use it with NVDI.

NVDI 4 is what | use, it makes use of
the Bitstream processor technology
and can interpret Speedo and True
Type fonts and there are loads of
these fonts available for your use.

Let’s concentrate on AtariWorks first.
The one drawback with this program
is it won’t run from the floppy drive,
that means you need a hard drive to
run it.

The program consist of 4 disks. Disk
1 contains the Main program,
Installation and Resource files. On
disk 2 and disk 3 you'll find the
dictionary files and the Thesaurus.
The fourth disk is Mastering
AtariWorks, this is the Hypertext
Guide used with Atariworks and it
offers quick references to all
commands with summaries and
tutorials. More on this as we go
along.

First you must install the main
program. Installing the software
couldn’t be simpler, make sure you've
got the master disk in drive one then
double click on INSTALL.PRG and
follow the screen instructions. You do
not need to install it in the boot drive
(partition C), instruct the program
which partition you prefer and the
install program does the rest. When
the installation is completed insert the
Mastering AtariWorks disk in drive A
and copy the following files into
partition C, MA_WP.ACC,
MA_WP.RSC, MA_WPC.RSC,
MA_DB.ACC, MA_DB.RSC,
MA_DBC.RSC and
MA_WORKS.CFG, the ACC files are
the Accessory files, they will load into
memory when you boot up the
computer. Next copy the folders
IMAGE.DAT, TEXT.DAT, PRINTERS
into your C partition or if you prefer in
the same directory as the Master
program and the TUTORIAL folder
into the same place.

After you’ve copied all the files into
your hard drive make sure you have
two empty accessory slots available
under the Desk menu to install the
hypertext guides. You must now
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re-boot your computer to install into
memory the two hypertext accessory
files. Move the mouse arrow to the
Desk menu on the Menu Bar and
click on AtariwWorks WP or AtariWorks
DB item name to display the
hypertext guide window. Now click on
the Configuration icon, highlighted in
icon tool bar screen dump, to display
the configuration
dialog box. All the
settings are made
in this dialog box.
Unfortunately | am
unable to screen dumb the dialog
box, but | will draw the fields
displayed in the box as they are
shown. You must click on them to
configure the program.

selector and open the folder then
click on the OK button to get the
pathname.

Next we need to initialize the printer.

Initialize Printer

Load Printer Driver

Save Printer Driver

Load in the printer driver by clicking
on the < Load Printer Driver > button,
the file selector will appear. Select the
printer driver filename in the
PRINTERS folder that represents
your printer and click on the OK
button to install. Now click on the <
Save Printer Driver > button to call

Text > FA\TEXT.DAT\

the file selector and enter the

printer driver name in the

To set the pathname for the program
to find each folder, click on the < Text
> button to prompt the file selector on
screen. Open the TEXT.DAT folder in
the drive partition you have chosen
and open the folder and click on OK.

Now repeat the same steps for the <

text fieid- All printer drivers have the
“PRT” extender. You can now save
the printer and all other settings in the
MA_WORKS.CFG filename using the
< Save Settings > button.

Mastering AtariWorks is a Hypertext
Personal Training Guide for all users.

Image > FAIMAGE.DAT\

Especially the novice user

Image > button. You must also set
the pathname for the Clipboard in
order for the Clipboard icon to work
correctly. Usually the hard drive
partition for this folder is drive C:\, |
keep this folder in the boot drive C:\,
but it is up to you depending the
space in that drive. Click on the
Clipboard field to display the file

will find the simple step by
step appraoch easy to understand.

Each AtariWorks command is
explained in detail and the necessary
information on how to use them. You
will find when trying to master,
AtariWorks Word processor,
Database or Spreadsheet and find
any topic difficult, just click on either
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Works File Edit MWindow Search Farmat Style

iintitled (WP

(Not Saved)

o

I

This screen is displayed when you click on New. | typed in my initials with a
point size of 144, it's an example to show what can be achieved with Works

on the DB.ACC or WP.ACC, which
should be installed as accessory
toois, and all the help is on hand.

The initialization of the printer in the
Wastering AtariWorks is to give you
the option to print out the Hypertext
Gu ide instead of reading it of the
screen, some users may find it more
difficult text on the screen.

You have also the choice of two text
sizes - small or large. To choose to
size, click on the desired text size
button to highlight and exit the dialog
box to change the text display size.

After you've configured all the options
found in the Configuration Dialog Box
you can start using the AtariWorks.
When you start the program you'll
see the item selector box displaying

the icons for each AtariWorks tools.

Word Processing is the default, this
icon is highlighted. Click on “New”
and a new document window opens
on the Desktop, if you click on
“Open” a file selector box listing all
the files and folders on the current
disk.

When you select a New Document
window you have a choice of
importing ASCII files with the
extender TXT or you can start typing
your own document. The program will
remind you that your document has
not been saved. To save the
imported ASCII document select from
the File Menu to display the Save
As... dialog box and type in your
chosen filename. The AtariWorks
word processor saves all documents

Tyne & Wear Atari User Group
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i [_Remove |
» [Configure]

i Lur
ANON BUBBLE JET 18e

Ouality: [Drart | [ZTEIM

o]

in the Works format with the extender
STW.

The screen dump on the previous
page, shows the three characters
with 144 point size, | typed them in
after | selected New Document. To
choose a different font, go to the
Style...Menu and choose Font, a Font
Face Selector dialog box will appear,
select the font and size then click on
OK. You can create Headers and
Footers, they are not displayed on
the screen, but only appear on the
printed document. The headers and

footers can have a different format
and font, you can aiso include Date
and Time and of course page
numbers. It also has a good Spelling
Checker, User Dictionary and
Thesaurus.

You can draw Shapes, Lines, Boxes
and Circles. You can cut, copy,
paste, resize or change the line
width of any selected pattern. You
can also import pictures, choosing
Import Picture... from the Edit Menu,
a dialog box appears giving you the
choice of the picture to import. You
can select GEM VDI Metafile, or GEM
VD! Bit image file, when you click on
OK a file selector box will appear to
select the picture.

What about using the Mail Merge
facility. There is no need to exit the
program and re-boot, move the
mouse pointer to the <File Menu>
and click on Close then choose New
from the same File Menu.

When you set up a new database

Works Fiic Edit Windaw Select Format Control

from scratch, because there’s

B Untitled (00) (Kot Saved) WMV B o A

no information in the
database yet, AtariWorks
asks you to set up fields first.

When you choose New from
the File menu, AtariWorks
opens a form window and
creates an empty document
with the name “Untitled”, you
are then asked for the name

<]

e

This screen display is a Form window.

of the first field. Type in the
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name, then click on Add Field button
or just press Return. The field name
you typed is accepted and the dialog
box reappears to type in the second

that field. You will see that the
information you are typing is
displayed in the top line, when you
press [Return], that entry you’ve just

Morks File Edit Window Select Farmat Control

1/3 <|6erun

alntitled T(Dl) (Not_Saved) ::

ddy Son ddr.

typed will be entered
into the field and the

)
Seaddrens_[ciy Town Cony _[pencodl] | next field is highlighted

1 | ready to enter your next
| information.

The screen dump

I displayed on the

1| | previous page is the
Form window and the

List window. To switch

e ]

‘ display shown here is a
i

between the windows

field name. After adding the last field
name you need click on Done. The
dialog box disappears and displays
the fields you have created in a form
window.

The first field is highlighted and you
can now enter your information into

go into the Format menu and the very
first option is either Show List or
Show Form, click on the one shown
to toggle the window. Entries can be
entered into the fields in either of the
windows, first highlight the field and
then type the information and press

Morks File Edit Hindow Select Format Options Chart

| [Return].

Al

IMPANY INVOICE IR 18T ()l‘ABTKIl QF 1994

21 You will find when you first
T2 create the fields that some of
11those fields are not large

-1 enough to show the full

w1 information. These fields can
-} | be enlarged with the mouse

"1 arrow, point the arrow at the
field box, press and hold the

o ) | l6ft mouse button and drag to
=0} | the right.

4 Ay Desaiptien . i

. 2 Hlectne Vs - Mode! #4251
S_ A Table Top Water Tilters Mudel #6211 |
(e] Dut Bir & Brsh '

1 B Bieuders Medel #0324 !
5 | Wi cwmrex Model #5711
EX " GraRange Model 7612 :
o] 4-Head VCR Modsl #1212 ! £121900 |

1 “ At Fadoon Corapnavrs wath 504-Megs ! 4,79 18
L A Atars VO amtor Model #4121 !
(33 ] 10 s anModel #6120

14 ¢ T Toduba 27" TV Model #671 IRy o
of g 1o 5

demonstration.

You can also change the

This screen dump is a Spreadsheet document appearance of the fields, to

put borders around field
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names, click on Border Name or
Border Data from the Format menu.
To put field names or entries in bold
type, click on Bold Name or Bold
Data in the Format menu.

You can also set field attributes to
determine how the information is
displayed. Click on the Set Field
Attributes in the Format menu to
display the Attributes dialog box. Click
the options you want for the field,
than click on the OK button. There
are loads more options available but
are too numerous to write about here.

As most of you will know a Spead-
sheet is made up of vertical columns
and intersecting horizontal rows. |
have not made use of the AtariWorks
Spreadsheet and therefore not
familiar with it. But | will include a
screen dumb with a Template for an
example.

When you start AtariWorks, the item
selector box containing four icon
tools, Word Processor, Database,
Spreadsheet and the fourth one is the
Tool icon, this is used to combine
AtariwWorks tools together. Copying
information among the Atariworks
tools is now easy. Select the
information, copy it to the clipboard
and paste it to its destination. You
don’t have to close windows or exit
the program you’re in.

VCS GAME
REVIEW

ets dip into the VCS cartridge bag,
and see what we have, it’s...

NAME: STAR RAIDERS FORMAT:
VCS 2600

SETUP

Connect up the system and plug in
the cartridge in the normal way, as
you have done all of your VCS life.

CONTROL
Console control:

(RESET)- start game (SELECT)- set
difficulty,

10 20 30 40 <- No. of targets
400 600 800 900 <- energy at start
BW/COLOR switch- works as usual

*.LEFT PORT switch- select CPU
on/off

*-RIGHT PORT switch- select shield
on/off

(*-NB: left position is on, and is fixed.
Right position is off, and allows
keypad control to function for on/off)
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Touchpad control
Touchpad keys work as labelled.

Fore View - Forward view out of
cockpit used for combat and general
sight seeing.

Gal Map - Displays the galactic map
showing the location of the base
square, and the current location of
the enemy and your self.

Hyperwarp - For engaging hyper-
warp, allowing fast travel to another
location on the galactic map, energy
permitting. Position cursor onto
desired destination square and
engage.

CPU on/off - Enable or disable
computer, necessary in game,
controls radar screen, photon cross
hair sights, makes various tones and
beeps that signal certain events.

Shields on/off - Enable or disable
shields, very necessary, without
shields one hit and your history.

Joystick Control:

Trigger - Each press will release a
photon charge, left and right bank
alternating - auto fire is useful.

Stick forward - Craft descends.
Stick back - Craft ascends.
Stick left - Craft turns left.
Stick right - Craft turns right.

GAME BRIEF

Select level Start game Select
shields/cpu View gal map Hyper to
enemy Attack enemy and destroy
(recharge/repair as required) Save
base accept new rank -End.

IN GAME PLAY

On switching on your console, you
will see a star field and the words
“Star Raiders (c) Atari 1982 at the
top. First select the level of game
play you want. Each time ‘SELECT’ is
pressed the border changes colour as
‘T10’ cycles up to ‘'T40’ and back
again,’T10’ being the easiest mission.
Press ‘RESET’ to start. Select
CPU/Shields either by touch pad
control or port switches. The main
view screen takes up the top 4/5 ths
of the scteen and shows your forward
view out side your craft, with two
horizontal cross hairs in the middie of
the screen. One protrudes from the
left hand side of the screen and the
other from the right, both are level
and both show the target path of their
respective photon charge, when
either photon bank is fired. The
bottom 1/5 th of the screen is for
information following left from right
you have:

‘EQ00O’ E, followed by a three digit
number, showing energy left.

‘X’ X="P,E,S,C’ here you have space
for a single alpha numeric character
which cycles through, ‘(P)hotons,
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(E)nergy, (S)hields, (C)PU. The
condition of each is displayed by its’
luminosity the brighter it is dispiayed,
the more damage to it.

‘TOO’ T, followed by the number of
targets to destroy, depending on the
level selected.

To the extreme right is a little radar
screen displaying enemy craft only.

Now familiar you can press
‘GAL-MAP’ on your touch pad, you
will see a sixteen square (4x4) grid.

Somewhere in this grid are three
different pieces:

1) The elaborate (flowery) shaped
piece is your base square.

2) The arrow head shaped piece is
the enemy force, upto forty of them
could be hiding behind it (wow!).

3) The last piece a very lively (read
bright and blocky) looking character,
represents you. This of course is the
famed paddle from super break-out -
oh mighty paddle what an honour this
is.

Without moving the joystick you will
see that your craft automatically
homes in on the enemy force, But it is
quicker to use hyperwarp. To
hyperwarp you use the joystick first to
move the cursor to your desired
destination , the cursor is behind the
paddle shape which represents your
position on the galactic map. It is also

slightly lower and a darker colour, of
which a thin band is visible as an
indication to you that something is
there, so move that joystick. Oh look
it's another paddle we have been
blessed again, let us bask in this
glory- aah. Once you have moved
your cursor to the location you desire
to hyperwarp to, press the ‘HYPER-
WARP’ key on the touch pad. Feel
that speed as the hyperwarp is
engaged, hear that sound- this is
what VCS life is all about. Provided
your not a coward your destination
was the enemy force (the arrow head
shape). You can press the ‘FORE-
VIEW’ key on the touch pad and let
the battle begin. First your craft
reduces its’ speed when your
destination is reached, then a tone
sound is heard signalling the enemy
presencé at this location (unless it
moved during your warp). As the
enemy appears before you a beep
sounds to alert you of this. At this
point your trigger finger should be at
one with your joystick. There are
three craft types to contend with:

1) An ‘H’ looking craft.
2) An inverted ‘V’ looking craft.
3) A pair of ‘Cymbals’.

Each craft type acts differently, but
die the same.

If you look at your radar it will show
you exactly where the enemy is when
it goes out of sight, Do not keep still
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at this point as you can easily be hit
from the side or behind. Every time
you sustain a hit energy is lost. When
your energy is around 200, it is
usually a good time to prepare to
recharge, depending on how close
you are to base. When recharging
energy, damage is repaired too.
Press ‘GAL-MAP’, on the touch pad,
move the cursor onto the base
square, press ‘HYPERWARP’ on the
touch pad, wait for hyperwarp to
finish, then wait for the message
‘complete’ to appear at the bottom of
the galactic map screen. Now
reposition the cursor over the enemy,
press ‘HYPERWARP’ on the touch
pad, then press ‘FORE-VIEW’ on the
touch pad, and carry on with the
battle. It is possible that the enemy
will end up on your base, along with
you, an indication of this is your
energy is recharged and any battle
damage you have is repaired. With
the enemy on your base you must act
fast to save it. The loss of your base
will mean no more recharging or
damage repair, and should you
destroy the enemy your ranking will
be lower without your base surviving.
Play ends when you or the invading
enemy Zylon force are destroyed.
You loose from a lack of energy or
from overwhelming battie damage
resuiting in the catastrophic loss of
your ship. The end of your foe is
signalled when ‘TOO’ is reached, and
upon your success a rank is awarded
to you.

OVERALL

VCS Star Raiders plays a good
game, and will hold your attention
during play, even though your enemy
is in a single formation and easy to
locate. It is not any easier to destroy,
because with smaller groups you rest
between skirmishes, and here it's one
long slog. With frantic break offs
when you need to recharge. As the
enemy draws ever nearer to
destroying your base, with you in
pursuit.

The game design is straight forward
graphically it's uncluttered, the sound
effects work well, and there are no
silly joystick moves, thanks to the
touch pad. Although the touch pad
has 12 keys, you only use 5 of them.
The rest of the keys are uniabelled
and have no function. Extra functions
might have complicated the game
play, but it would have been nice to at
least be given access to them. The
lead on the touch pad is not very
long, if it was longer, more ergonomi-
cally designed, and incorporated
some of the main console functions,
ie RESET, SELECT, or PAUSE. This
would have allowed you to get more
comfortable for play. The touch pad
can either be placed next to the VCS,
held in your hand, or placed
somewhere close like on your {ap.
The first few games you play help to
familiarize you with the touch pad,
this is what happens when your used
to paddles and joysticks. When you
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are more familiar with the controls
however, real play can begin.

>>>>SEND<<<<

XE Video Mod.

Part 1.
by Ye Olde Atari 8-bit
he XE series of 8-bits are
noted for their bleached out
colour, and are otherwise
tolerable, a good solution for
improved video performance was
published in AC, by Charles Cole.
This is an upgrade | have used and it
works very well. Independent to this
upgrade is another method of
restoring colour to the XE range, and
can be used along side the upgrade
provided by Charles Cole.

It you open up your XE and look at
the bottom left hand corner of the
mother board to where the crystal is
and notice a vacancy of components
to the right of it (just under IC
designation U6, C06199X-XX
Freddie). The components are:

Q4 = TRANSISTOR 2N3904 NPN
Q5 = TRANSISTOR 2N3904 NPN

R26 = RES: 2.2K OHM 1/4W carbon
@ 5%

R18 = RES: 220 OHM 1/4W carbon
@ 5%

R27 = RES: 220 OHM 1/4W carbon
@ 5%

R29 = RES: 1M OHM 1/4W carbon
@ 5%

R28 = RES: 910K OHM 1/4W carbon
@ 5%

C32 = CAP: 18pf ceramic axial, NPO
C33 = CAP: 10pf ceramic axial, NPO

Solder in the respective component to
its’ circuit location, and on successful
installation of the components
referenced above, you shall see full
rich colour performance, as it should
have been.

Just as the vacant U35 IC slot is for
an alternative gate array arrange-
ment, these components form part of
an alternrative video circuit.

On an older production XE you might
be fortunate in having one of these
alternative circuits fully working, but
for the mass majority, of production
XE’s you do it yourself.

Any blunder(s) you make are of your
own doing, so congratulations.

>>>>SEND<<<<
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XE Video Mod.

Part 2.
by Ye Olde Atari 8-bi

his is an addition to that fine

article mentioned in part 1,

the XE video upgrade by

Charles Coles. Unlike super
video 2.1XL, the XE video upgrade
does not include a CV disable switch.
This article shall include one and
when in use it will act like the CV
disable switch as used in super video
2.1XL, when the luminance signal is
used from the monitor jack.

To go over the switch function, if your
video source is connected through
the luminance output of your switch it
will toggle composite video on and
off, composite video affects the clarity
of a luminance signal. If your video
signal is from your composite video
output, then the luminance signal is
toggled on and off, adding luminance
to the composite video signal will give
a sharper signal, the main reason for
this little modification.

PARTS REQUIRED
1 x 25 OHM resistor 1/4W @ 5%
1 x 3 pin 2 position SPDT switch

2 x lengths of insulated wire
1 x length of insulation tubing

Open up your XE to get to the board,
at the rear in front of the monitor jack,
you will find a line up of components.
Using the transistor Q3 as our
reference component. To the right of
Q3 we have a resistor R204, mark
this component. Three positions
further down from Q3, we have
component L7 mark this component
too.

WORK OF BOARD

1) Trim two insulated wires to go from
either of the components marked on
the circuit to go to where you desire
to have your switch mounted.

2) solder one end of each wire to the
switch, soldering one end of one wire
to the middle pin of the switch, and
one end of the other wire to any one
of the two remaining outside pins.

WORK ON BOARD

3) On resistor R204 marked earlier,
we shall be soldering our 25 OHM
resistor, on the top lead end nearest
the monitor jack. So trim one end of
our 25 OHM resistor to a suitable
length, then solder it to the top end of
R204.

4) Now solder any one of the lengths
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of wire attached to the switch, to the
top end of component L7 marked
earlier.

5) Before soldering the remaining
wire to the top lead end of our 25
OHM resistor,(which is soldered to
R204) get some insulation tubing like
heat shrink, with enough length to
cover the resistor body and the
resulting solder joint to be performed
between the wire and the 25 OHM
resistor. Shimmy this length up the
remaining wire out of the way, so you
can slide it down to cover the 25
OHM resistor and joint after soldering
it.

6) Now trim the remaining lead of the
25 OHM resistor to a suitable length
and solder the remaining wire onto
the 25 OHM resistor lead, and slide
down the insulation to cover.

You can now switch on your XE and
check the function of your switch.
Once happy with the performance
you can mount your switch and
reassemble your XE.

Any blunder(s) you make are of your
own doing, so congratulations.

>>>>SEND<<<<

XBOOT

What is XBOOT?

Let me start at the beginning. When
you run your ST from floppy disks
you will find that it is easy but slow.
You set up each individual disk with
your program and away you go.

If you have a Hard Drive attached
and you use it as the boot drive, you
will find that you must do some
alterations before you can run your
program.

Anybody, running his or her system
from the hard drive, will know that the
"C” partition is the boot disk as
default, unless you change it.

Let me give you an example: | use
XBOOT - a Boot Manager. It is
installed in the "C” partition, when
installed you will find XBOOT has
installed itself into the Auto Folder
and must run as the very first
program.

The main screen of XBOOT will be
displayed on the screen after boot up
and all the programs in the auto
folder all the accessory files and CPX
files will be shown in their proper
section of the main XBOOT screen.
You can now select the programs you
want to run by clicking on each
program and also the accessory files
to run with the programs. Those
selected will have a tick beside them.
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DISK CONTENTS

Side A:

The Wall - Tetris type game.

Deathzone - Shoot them up type.

Puzzle - Figure it out yourself.

Tetrix - Another tetris clone.

Maze War - As the name suggests.
Resurex2 - Alt Reality City & Dungeon Maps.

Side B:
Word Puzzles
Including Crossword, Hide 'n’ Go Search with editor and printer.

XBOOT

continued

I run TIMEWORKS with G+ Plus, the
accessories are G+Plus Accessories,

HotSaver and (X)IMG-Snapshot. |
therefore would click on G+Plus in the
PRG section and in the accessory
section click on G+Plus Accessories,
HotSaver and (X)IMG-SnapShot, all
these names will have a tick beside
them now and are a SET. | would
now click on the Set Icon, that’s the
second one down in the stack of the

The XBOOT screen is divided into
four main sections. On the left is the
section for the auto folder programs
("PRG™), next to that is the section for
accessories ("TACC"), to the right of
them is the CPX modules ("CPXs”).
The fourth section is the ("SET”)

partition, this is where you set up the
program to run.

Let me give you an example:

picture synbols and enter a name, for
this Set | chose TimeWorks 2. This is
only a short explanation on how best
to run your programs from the hard
drive.
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ANNOUNCEMENT
THE TWAUG CD

We are putting together a CD containing our complete updated
P.D. Library and issue disks.

These will be in ATR format and ready to run from the CD.

All our Newsletters will also be on and ready to read in ADOBE
PDF format.

Adobe Acrobat Reader is on the CD.
Complete P.D. listings in PDF format.
Emulators and emulator utilities are also included.

—

The CD will be available at the show. Price ?

36 Tyne & Wear Atari User Group



